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SSSSterling Heights   terling Heights   terling Heights   terling Heights   

Public LibraryPublic LibraryPublic LibraryPublic Library    

 

T 
he Sterling Heights Public Li-
brary, at 40255 Dodge Park 
Road, is located  just south of 

Utica Road.   A large sign reading 
"City Center" marks the driveway to 
the library and parking.   The Pro-
gramming Center, where the meeting 
is held, is just inside the front door of 
the library. 

MAIN MEETING: MAIN MEETING: MAIN MEETING: MAIN MEETING: TUESDAYTUESDAYTUESDAYTUESDAY Oct  1 Oct  1 Oct  1 Oct  1 
7:30PM 7:30PM 7:30PM 7:30PM     

Macomb Community College  
South Campus 

14500 E 12 Mile Road, Warren 
John Lewis Community Center  

(Building K) 
(Enter from Hayes Road) 
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Apps 
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This Month’s Main Meeting Topic:This Month’s Main Meeting Topic:This Month’s Main Meeting Topic:This Month’s Main Meeting Topic:    
“Smart devices” presented by Eric Hayes,  IT 

Coordinator and Webmaster for the Royal 

Oak Public Library 

SIG SIG SIG SIG     

Meeting:Meeting:Meeting:Meeting:    
In November - 

 7:00 at the  

Sterling Heights  

Public Library 

 
(The SIG will plan to meet every 
other month, at this location, if  
people  continue to attend.) 
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Resource People:Resource People:Resource People:Resource People:    

Guests and visitors are welcome. People can attend any SHCC meetings during two consecutive months before decid-

ing to become a member or not.  Meetings include the main meeting and SIGs.  July and August don't count since there 

is no main meeting.  Membership includes admission to all SHCC functions and the newsletter.  Membership is open to 

anyone.  It is not limited to the residents of Sterling Heights. 

  DUES:   $25/YEAR 

Four  Month Meeting  Schedule:Four  Month Meeting  Schedule:Four  Month Meeting  Schedule:Four  Month Meeting  Schedule:    

CLUB ADDRESS:  PO Box 385,  Sterling Heights, MI  48311-0385 
CLUB E-MAIL ADDRESS:  Info@SterlingHeightsComputerClub.org 
CLUB WEB PAGE: http://www.SterlingHeightsComputerClub.org 

As a member of SHCC, you can attend 
meetings of other clubs where we have 
reciprocating membership agreements, at 
no charge. 
 

Computer Club of Marysville and 

Port Huron (COMP) 
Time:   1st Wednesday, 7:00PM 
Place: Mackenzie Bldg, Room 201, St 
Clair Community College, Clara E 
McKenzie Library-Science Building, 

323 Erie St. 
Port Huron, (810) 982-1187 
Web Page: http://www.bwcomp.org 
Reciprocating: Yes 
 
 
 
 
 

Newsletter  submissions  are  due  10  days before the club meeting, but the 
earlier the better. They should be sent to : 
       WYSIWYG Publisher 
       5069 Fedora,  Troy, MI 48098 
OR at the e-mail addresses:  newsletter@SterlingHeightsComputerClub.org 

Unless stated otherwise, all materials contained in this newsletter are copyrighted 
by the Sterling Heights Computer Club. License is hereby granted to other clubs 
(non-profit) to reprint with credit. 

The WYSIWYG was printed by STERLING PRINTING  AND 
GRAPHICS, located at  35976 Mound, Sterling Heights, MI 48312. 

South Eastern Michigan Computer 

Organization (SEMCO) 
Time:    2nd Sunday at 1:30PM 
Place: The Engineering Society of 
Detroit 20700 Civic Center Dr. South-
field,  MI 48076 Suite 450 4th Floor 
Web page: http://www.semco.org 
Reciprocating: Yes 
 
The OPC (Older Persons Com- 
mission) Computer Club  
Time:   Every Tuesday at 10:00  
Place:  OPC in Rochester   
       248-656-1403.  
Web page: www.opcseniorcenter.org.  
go to "Site Map", then to "Computer 
Club" for club information. 
No cost for residents to join or attend 
meetings. $150 fee for non-residents, 
(full facility usage) or $1 per meeting. 
Reciprocating: No 

Other Computer Clubs:Other Computer Clubs:Other Computer Clubs:Other Computer Clubs:    

OCTOBER 2013 
1  - SHCC– “Smart de-

vices” presented by 

Eric Hayes,  IT Coor-

dinator and Webmas-

ter for the Royal Oak 

Public Library 
2   - COMP meeting 
13 - SEMCO meeting 
?   -  SIG meeting 
 

NOVEMBER 2013 
5  - SHCC– Main Meeting 
6  - COMP meeting 
10 - SEMCO meeting 
?   - SIG meeting 

DECEMBER 2013 
3 -  SHCC– Main Meeting 
4  - COMP meeting 
8  - SEMCO meeting 
?  - SIG meeting 
 
 

 

JANUARY 2014 
7  - SHCC– Main Meeting 
1  - COMP meeting 
12 - SEMCO meeting 
?   - SIG meeting 

Paul Baecker 
 
Lindell Beck 
Ron Frederick 
Jerry Hess 
Rick Kucejko 
Patrick Little 
Sharon Patrick 
John Rady 
Rick Schummer 
Don VanSyckel 
Jack Vander-Schrier 
      (Call Jack after noon) 

586-286-2314 
 
586-939-4278 
586-294-5687 
586-566-6166 
248-879-6180 
586-264-1497 
586-268-3626 
248-258-9515 
586-254-2530 
586-731-9232 
586-739-5952 
 

webwatch@sterling  
heightscomputerclub.org 
Ljb48312@gmail.com 
frederic@gdls.com 
jhess@comcast.net 
rick@kucejko.com 
pblittle@wideopenwest.com 
espee37@att.net. 
john.rady@hotmail.com 
rick@rickschummer.com 
don@vansyckel.net 
jvanders@comcast.net 
 

Contact Information:Contact Information:Contact Information:Contact Information:    
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SSSSHCC Emergency HCC Emergency HCC Emergency HCC Emergency 

CaCaCaCannnncellationcellationcellationcellation    
    

T 
he Sterling Heights Computer 
Club might find it necessary to 
cancel an event if the weather 

gets bad enough.  All members of 
SHCC have an email address.  One of 
the SHCC officers will send an email 
to the addresses SHCC has on file 
alerting members to the event cancel-
lation.  Decisions will not be made 
before 4:00 PM and decisions will be 
made by 6:00 PM for the regular 7:30 
PM meetings.  If weather is question-
able an email confirming that the 
event is NOT cancelled might be sent, 
so please carefully read any SHCC 
announcement about events.  If your 
email is broken, call an officer. Don't 
leave a message, call another officer if 
you don't talk to someone live.  It is 
your responsibility to keep the email 
you have listed with SHCC current. 

� � � � � 

LLLLast Month's Meetingast Month's Meetingast Month's Meetingast Month's Meeting 

 

T 
he September meeting was 
really good.  Mr Stephen 
Legler from Microsoft pre-

sented "Windows 8.1 Usability - Lev-
eraged for Touch and Non-Touch De-
vices".  Mr Legler did a great job and 
Win 8.1 looked pretty good.  

� � � � � 

I 
f you weren't at the September 
meeting, you missed a really 
good one.  Mr Stephen Legler 

from Microsoft presented "Windows 
8.1 Usability - Leveraged for Touch 
and Non-Touch Devices".  Mr Legler 
did a great job and Win 8.1 didn't look 
so daunting. 
 
The USB 3.0 board in my desktop 
misbehaved (see last month and how 
USB 3.0 is now an integral part of my 
desktop system) and I thought possi-
bly I should look for another PC with 
'native' USB 3.0.  I looked around and 
decided I'd check to see what was 
available refurbished.  There are two 
stores that have presented at SHCC, 
Aardvark and Micro Center.  I 
checked Aardvark and was surprised 
to find them out of business.  When I 
checked Micro Center’s web site it 
listed quite a selection of refurbished 
PCs.  The issue with the Micro Center 
listings is that very few of them listed 
the PC specs about the USB ports and 
many didn't list USB ports even as a 
feature. 
 
I did eventually find one with USB 
3.0 ports.  Actually it had two USB 
3.0 ports and four USB 2.0 ports.  I 
suppose my keyboard and mouse can 
limp along on USB 2.0 ports.  I'll just 
have to type slower.  The issue with 
this PC though is that it came with 
Windows 8.0. I was hoping it would 
have Windows XP Professional (many 
of the refurbished PCs come from a 
lease program and leases are generally 
with a business which generally uses 
Windows XP Professional.)  I was 
impressed enough with last month's 
presentation to take a chance. 
 
It only took five minutes to decide to 
put Windows XP Professional on the 
PC and I would have right then but I 
wanted to make the backup disks first.  
Well, this started another adventure.  
The PC doesn't make a backup disk, it 
makes a backup thumb drive.  The 
thumb drive needed to be at least 16 
Gb and fortunately I had one. After 

three hours I ended it.  
I tried another thumb 
drive and again ended 
it after about three hours.  This time 
there were not as many files as the 
first time.  I had an idea. I have a two 
inch USB extension cable and I used 
it to connect one of the thumb drives.  
I did this because the extension has a 
narrow USB plug and I noticed that 
the chassis cut out for the USB 3.0 
sockets didn't provide much clearance. 
This time after 15 minutes the pro-
gram reported it was done.  I took this 
as proof that the lack of clearance 
with the chassis cut out was causing 
the one thumb drive to not work at all 
and the other to work in some inter-
mittent mode. 
 
During all the waiting I was doing I 
had another thought, after all last 
month's presentation was Windows 
8.1 not 8.0, so I decided to wait for the 
8.1 update next month.  Then if I'm no 
happier, it's Windows XP Profes-
sional.  I'll take my chances after next 
April when Microsoft stops support-
ing XP.  It's worth it for the usability 
and lack of aggravation. 
 
I'll have to see how this all works out. 
 
This month should be another dyna-
mite presentation.  Mr Eric Hayes 
from the Royal Oak Library will be 
presenting.  Also don't forget the PIG 
SIG at 6:00 before the meeting.  It's 
across Hayes at Travan's.  

          The President’s Pen The President’s Pen The President’s Pen The President’s Pen  
                 by Don VanSyckel 

� � � � � 

DDDDoor Prizesoor Prizesoor Prizesoor Prizes    
 

T 
he SHCC offers door prizes at 
most regularly scheduled club 
meetings. In September the 

winner’s circle included: 
 

Virginia Chojnowski won Star  
Office 8 software 
 

Lindell Beck won Component 
Video Cables 
 

Jane Minnick won a Photoshop 
magazine 
 

Mike Bader won a Roku 
 

Martee Held won a Red Hat Linux 
9 Bible 
 

James Waldrop won Picture-it soft-
ware 
 

Ralph Osinski won a TR-1 tape 
 

Richard Katnik won Photoshop  
software 
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I 
t is time to re-elect our officers.  
Here is the process, the jobs, and 
responsibilities: 

 
The nomination process is simple.  
You can nominate yourself or have 
another person nominate you for one 
or more of the offices.  All the offices 
(president, vice-president, secretary, 
and treasurer) are elected for a one 
year term starting in January and 
c o m p l e t i n g  i n  D e c e m b e r . 
Nominations are taken in October and 
just before the elections in November.  
You must be a member to be 
nominated or to nominate someone. 
 
The elections are usually held at the 
regular meeting closest to November 
1st.  This year they were delayed for a 
month. The easy way to remember 
this is that we hold our elections on 
the same night as the local and 
national elections are held, in years 
when there is a national election.   
 
Only members of the SHCC can vote.  
Ballots will be handed out at the sign-
in door.  The elections are held during 
the business portion of the meeting.  
The person with the majority of the 
vote for the office is the winner, for 
each office. 
 
The jobs of each office are flexible.  
Some are defined, some change from 
office to office depending on the 
officers’ capabilities and availability. 
In reality the president makes sure the 
meeting topics are set, the speakers 
are prepared, writes thank you notes to 
presenters and door prize contributors, 
runs the regular club and officer 
meetings, publishes the minutes to the 
officer meetings, takes phone calls 
from potential members and sends 
information to them, audits the 
monthly treasurer report and 
membership databases, tracks door 
prizes, and handles most of the 
publicity issues for the club.  The 
WYSIWYG column is optional, but a 
great forum to pass along information 

Club Officer Club Officer Club Officer Club Officer Election AnnouncementElection AnnouncementElection AnnouncementElection Announcement    

to the members.  The president also 
makes sure that the different 
coordinators are appointed and do 
their jobs.  The president enforces the 
constitution and Club's policies.  The 
president  does whatever things cannot 
be done by anyone else. The key  to 
this job is delegation. The more the 
president delegates the less there is to 
do. 
 
The Vice President has the catch all 
job.  So far to date the vice-president 
has not had to step in for the president, 
and there have not been any state 
funerals that they have had to attend.  
This is an important job.  The person 
must be flexible and be prepared to 
run the regular and officer meetings if 
the president cannot attend.  This 
officer usually picks up a project or 
two during the year to lift the burden 
from other officers. Presently the vice 
president arranges for our meeting 
speaker, but help is available as 
needed. 
 
T he secre ta ry mainta ins  the 
membership database which is tracked 
in an Access database.  They also put 
together "New Member Packets" and 
give them to newly joined members, 
and members who renew.  These 
packets are already printed, some 
assembly required!  The secretary 
audits the treasurer report to make sure 
that the membership money collected 
matches the membership counts in the 
database, print the mailing labels for 
WYSIWYG mailing, and maintains 
several reports such as a membership 
list and attendance sheet.  The 
secretary makes sure that sign-in table 
materials needed at each regular 
meeting are there before the meeting, 
and before people start showing up. 
 
The treasurer maintains records for all 
the money taken in and paid out from 
the Club's checking account.  The 
SHCC currently uses Quicken to track 
the funds and generate reports for the 
officers.  The treasurer also audits the 

Presenters WantedPresenters WantedPresenters WantedPresenters Wanted    
 

T 
he officers invite any member 
to make a presentation at the 
main meeting. 

 
If there is some software you have 
been using and think others may be 
interested as well, or there is a 
computer topic you would like to 
present to other members, please call 
or e-mail Don VanSyckel. Making 
presentations is not that difficult.  The 
hour goes by before you know it and 
there is always enough material to 
cover in a software package so that 
the hour is easy to fill. 
 
If there is a topic you are interested in 
or something you would like 
demonstrated, please see any of the 
officers.  They are always interested 
in what the members would like to 
see.    

� � � � � 

membership counts.  The treasurer 
makes reports to the officers at the 
officers meeting and four times a year 
to the Club's membership.  All the 
receipts are collected and maintained 
by the treasurer. 
 
All the officers attend the officer 
meeting that takes place during the 
week after the club meeting.  It starts 
at 7:30PM; time and date are flexible 
to the liking of all officers. 
 
We hope everyone considers this 
invitation, this call to service.  It is 
some work, and it is a lot of fun.  
Normally it takes 3 to 5 hours a month 
(give or take a few hours) outside of 
the meetings.  The president's job 
might take a little more, but remember 
that delegation can lower the burden.  
If you have any questions concerning 
the duties, feel free to give any of the     
officers a call. 
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careful to use only quality media. Of 
the dozens stored at home, some for 
several years, I've had problems with 
only one, which can be read only on 
the drive that created it. On the other 
hand, the outer tracks of several music 
CDs stored in my car are no longer 
playable. Another problem is the low 
quality of CD-ROM and DVD drives, 
with Blu-Ray being especially bad. 
Blu-Ray drives are acceptable for 
play-back, but their lasers frequently 
burn out after writing just a few discs. 
This is unfortunate, as the capacities 
of CD-Roms and DVDs are rapidly 
becoming too low to be really useful. 
 
If you use optical storage for archiv-
ing, consider using the free program 
dvdisaster (http://dvdisaster.net/en/) 
for Linux, OS-X, and Windows, 
which adds error-correction and thus 
allows you to recover your stored 
files, even though up to 20 percent of 
the bits on the medium are corrupted. 
You need a disk-burning program that 
can create a file (called an iso-image) 
that is a bit-for-bit image of a CD-
ROM or DVD and also has the ability 
to copy an iso-image to an optical me-
dium. The procedure for creating an 
error-resistant disk is the follows. 
 

• Use your disk burner to create an 

iso-image, which must be at least 
20 per cent smaller than the ca-
pacity of the medium. 

 

• Use dvdisaster to add error-

correcting data to the iso-image. 
The screen-shot below shows this 
in progress. After creating this 
image, click on the Verify button 
to check that it's good. 

 

• Finally, use your disk burner to 

write the iso-image to the optical 
medium. 

 
 Periodically scan your optical media 
(using dvdisaster's Scan button) for 

errors. If they begin to appear, recover 
the data using dvdisaster (which will 
produce an iso-image), create a new 
disk, and discard the one with the er-
ror. Until the medium begins to de-
velop errors, you can read it like any 
other disk using your usual software. 
 
Magnetic storage, in the form of ex-
ternal hard disks, offers high transfer 
speed and high capacity, making it 
attractive for many applications. It is 
also has the lowest cost per byte. To 
achieve this performance, these de-
vices are assembled with very tight 
clearances, which means they must be 
sealed against air-borne contamina-
tion. The magnetic disks cannot be 
separate from the motor and head as-
semblies, making these devices much 
larger and less rugged than electronic 
storage devices. Here, you have a 
choice of interfaces with USB being 
the most common, followed by E-
SATA. USB-3 drives are beginning to 
appear, but are considerably more ex-
pensive than USB-2, although this 
will surely change, probably soon. 
Diskettes are now obsolete, for good 
reasons. Their capacities are tiny, and 
their reliability is low. You can still 
buy drives, but their quality is very 
poor, with many delivered dead-on-
arrival or failing very quickly. If you 
still have valuable data on diskettes, 
you should transfer it to a better me-
dium soon. 
 
Internet storage, commonly called 
“the cloud” is expanding rapidly. 
Modest capacities, up to around five 
Gigabytes, are widely available with-
out charge. Transfer rates can be low, 
often just a few tens of kilobytes per 
second, and of course, the storage is 
available only if you have an Internet 
connection. There are also concerns 
about how secure the data is and 
whether it will continue to be avail-
able if the vendor goes out of busi-
ness. 
 
Which of these approaches you use 
depends on your application. For syn-
chronizing the data among your own 
computers, Internet storage is the most 
convenient. Once you have set it up, 

External StorageExternal StorageExternal StorageExternal Storage    
by Dick Maybach, member, Brookdale Computer Users’ Group, NJ             

www.bcug.com    n2nd@charter.net 

A 
lthough we use external stor-
age much less than in the 
early days of home comput-

ing, it is still an essential technology 
for backing up internal hard disks, 
exchanging files among different 
computers, and expanding storage ca-
pacity. The increasing size of files had 
made obsolete many older technolo-
gies, and those that are still attractive 
fall into four types: electronic, optical, 
magnetic, and Internet. 
 
There are many variations of elec-
tronic storage, but two are now domi-
nant, USB memory sticks and SD 
cards. They have similar capacities 
with current “sweet spots” (capacities 
where the cost per byte is lowest) of 
around 16 Gbytes, although this is 
continually moving up. SD cards are 
typically faster, but appear to be less 
rugged with exposed connections and 
thinner packages. I have carried a na-
ked USB memory stick in my key 
case for many years, and it has never 
failed, but I always keep my SD cards 
in their plastic cases. USB sticks have 
the further advantage that every com-
puter has USB connectors, while SD 
access is less common, and although 
memory card readers available are 
very cheap, they also have low quality 
and often are unreliable. The circuits 
used for electronic storage do have 
finite lifetimes, in that they wear out 
after a (very large) number of writes; 
however, the risk is negligible for ex-
ternal storage devices. 
 
Optical storage is problematic, be-
cause much the available media is of 
poor quality and may begin to develop 
errors in just a few months. Even 
high-quality media rapidly deteriorate 
if exposed to high heat or humidity. 
For more on this, see my article, Us-
ing DVDs for Long Term Storage, 
BCUG Bytes, June 2008, available at 
http://www.bcug.com. Actually, my 
own experience with CD-ROMs and 
DVDs has been good, although I'm 
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aster to safeguard your archived DVD, 
you must be sure not only that the pro-
gram runs on your new PC, but also 
that it uses the same methods as those 
used to record the data, and of course 
the new PC must be able to read 
DVDs. 
 
For sharing photos or files with 
friends, Internet storage is hard to 
beat, although mailing them a DVD or 
CD-ROM also works well, especially 
if they want to show the pictures to 
their friends. 
 
To expand internal disk storage capac-
ity, the preferred solution is an exter-
nal hard disk with an E-SATA inter-
face, although USB-3 is not a bad so-
lution. Most likely, you would use E-
SATA for a desktop, since it requires 

the contents of the synchronized di-
rectories are always identical, no mat-
ter which computer you use to make 
changes. Since the information resides 
on every PC, you lose nothing if the 
cloud vendor discontinues the service. 
 
For transferring files between your PC 
and a friend's, a USB memory stick 
(up to a few Gbytes) or a USB hard 
disk (for larger transfers) is the best 
choice. Almost every computer has a 
USB port, so your friend doesn’t need 
to install any special software or hard-
ware to affect the transfer. I always 
carry an eight-Gbyte USB memory 
stick, formatted as FAT-32, in my 
key-case, and I've never found a com-
puter that couldn't read from and write 
to it. (Actually, my stick has two par-
titions, a seven-Gbyte FAT-32 one for 
transferring files, and a one-Gbyte 
Linux one containing Parted Magic. 
See my article Parted Magic: Lots of 

Disaster-coping Tools, BCUG Bytes, 
April 2012, available at http://www.
bcug.com. This means I always have 
the ability to transfer files and a tool 
kit to solve computer problems.)  
 
For backing up your PC, and external 
hard disk is the only reasonable solu-
tion. These feature high capacities, 
fast transfer rates (especially if 
equipped with a USB-3 interface), and 
high reliability. Their bulk and rela-
tive high fragility are not serious prob-
lems in this application. 
 
External hard disks are also good for 
archiving things like photos and finan-
cial data, but you could use DVDs, 
provided you add error-correction us-
ing and store them in a benign envi-
ronment. For added security, consider 
making more than one copy, and ei-
ther transfer the information to new 
media every few years or periodically 
scan it for errors using dvdisaster. Ar-
chival storage is an especially difficult 
problem. Computer technology is 
changing fast, and you must stay alert 
lest you lose the ability to access your 
archives (as happened to me when 5 ¼ 
inch diskette drives disappeared from 
PCs). For example, if you used dvdis-

an expansion card, and USB-3 on a 
laptop (USB-2 if your laptop is older 
or not top-of-the-line). Mac owners 
could consider Firewire or Thunder-
bolt. 
 
As you can see, there is no single so-
lution, unlike in ancient times when 
diskettes were universal (or if we go 
back to near pre-history, cassette 
tapes, audio tapes, punched paper 
tape, or even punched cards). How-
ever, there is a good and inexpensive 
solution for every application. 
 

This article has been obtained from 

APCUG with the author’s permission 

for publication by APCUG member 

groups. 

W 
ith a Windows Live ID 
you have access to Micro-
soft’s Office Web Apps. 

This lets you open, edit and share 
Word, Excel and PowerPoint docu-
ments online using SkyDrive. So you 
can work with your documents from 
any computer whether it has the Of-
fice applications installed on it or not. 
Go to http://skydrive.live.com in a 
web browser to log on or sign up for a 
Windows Live account.  
 
Store Office documents on SkyDrive 
to view and edit them in a browser. Or 
share documents stored on SkyDrive 
by linking to them in an email, blog or 
social network.   
 
Save to or Upload to SkyDrive Docu-
ments generated on your home com-
puter can be saved to SkyDrive or up-
loaded. Use Save & Send to save an 
existing Word, Excel, or PowerPoint 
file. Select Save to Web, Sign in to 
your Windows Live Account, and 
then click OK. Specify a folder on 
SkyDrive, and click Save As. Type a 
name for the file and click Save.   

SkyDrive & Office Web Apps SkyDrive & Office Web Apps SkyDrive & Office Web Apps SkyDrive & Office Web Apps     
by Lynn Page, Editor/Webmaster, Crystal River Users Group, FL 

www.crug.com   lpage46@tampabay.rr.com 

I think it is easier to create the docu-
ment save it on the hard drive and 
then upload it to SkyDrive. In the 
SkyDrive menu bar click Upload. 
Then either drag and drop files from 
your Documents folder to the upload 
box or browse to and select them for 
upload. To open a document in Sky-
Drive, select the folder where docu-
ment is saved, and click the file name.   
 

Create New Documents in the Web 

Browser  

With the Office Web Apps you can 
create Word, Excel or PowerPoint 
files right in a web browser. The Of-
fice application doesn’t have to be 
open or even installed on the com-
puter.   
 
Sign into SkyDrive and click the kind 
of document to create in the Create 
drop down menu. In the dialog box 
type a name for the document and 
click the Create button.  
 
A new document opens for editing in 
the appropriate Web App. Simply cre-
ate the document as you would in the 
Office application. The Web App will 
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not have the full features of the Office 
2010 application but is familiar.   
 

Share Files on SkyDrive  

SkyDrive allows you to share your 
Office documents, photos and other 
files. You can share individual files or 
an entire folder.  In SkyDrive locate 
the folder or file to share and place a 
check in the selection box. Click Shar-
ing on the Menu bar. The default 
method of sharing is by email. This 
lets you give specific people permis-
sion to access and even edit your files. 
Add the email addresses for those who 
will be reviewing the files, add a mes-
sage and click the Share button. To 
access the document the recipients 
must have an account or create one.  
 
The Post to option places a link to 
your SkyDrive files on a social media 
service like Facebook. I wouldn’t 
choose this method of sharing as it is 
open to any of your friends or their 
friends if they repost.  
 
The Get a link sharing option creates a 
link you can send to others. The ad-
vantage is they do not need to have a 
SkyDrive account. The disadvantage 
is that anyone with the link can access 
the file. I would use the View only 
option for sharing a link. It allows 
anyone with the link see the file. The 
View and Edit link allows anyone 
with the link to see and edit the shared 
files. If you select Public sharing any-
one can search for and view the public 
files. 
 

Share Files on SkyDrive  

SkyDrive allows you to share your 
Office documents, photos and other 
files. You can share individual files or 
an entire folder.   
 
In SkyDrive locate the folder or file to 
share and place a check in the selec-
tion box. Click Sharing on the Menu 
bar. The default method of sharing is 
by email. This lets you give specific 
people permission to access and even 
edit your files. Add the email ad-
dresses for those who will be review-
ing the files, add a message and click 
the Share button. To access the docu-

 

ment the recipients must have an ac-
count or create one.  
The Post to option places a link to 
your SkyDrive files on a social media 
service like Facebook. I wouldn’t 
choose this method of sharing as it is 
open to any of your friends or their 
friends if they repost.  
 
The Get a link sharing option creates a 
link you can send to others. The ad-
vantage is they do not need to have a 
SkyDrive account. The disadvantage 
is that anyone with the link can access 
the file. I would use the View only 
option for sharing a link. It allows 
anyone with the link see the file. The 
View and Edit link allows anyone 
with the link to see and edit the shared 
files. If you select Public sharing any-
one can search for and view the public 
files. 
 

Organize/Manage SkyDrive  

SkyDrive storage can be managed in a 
similar way as Documents on your 
hard drive. A new SkyDrive account 
will have three folders: Documents, 
Pictures and Public. 
 
Create new folders with the Create 
drop down menu. Folders can be 
nested within these three main folders 
or added on the main file location. Go 
to the location to add a folder, click 
Create and select Folder from the drop 
down menu. Enter a name for the 
folder and it is all set for storing files. 
The path to the files or folders is 
shown in the title bar. The number in 
the bottom right corner of a folder 
shows the number of files it contains. 
 
If you change your mind about how 
folders should be organized you can 
move them. To move a folder, go to it 
in SkyDrive. On the Mani menu click 
Folder actions and select Move folder 
to from the drop down menu. In the 
dialog box add a new folder or select 
the location to move the folder.  
 
The Manage drop down menu is used 
to manage files. It allow for renaming, 
deleting, moving and copying files. 
The trick is that you must go the 
folder containing the file and place a 

check in the selection box. That opens 
additional commands on the Menu 
bar.  
 
To move the file place a check in the 
selection box (top right corner), click 
Manage in the Menu bar and select 
Move to in the drop down menu. In 
the dialog box select the location for 
the file to be moved. 
 

Word Web App 

The Home tab contains basic text and 
paragraph formatting including Styles.   
 
The Insert tab is used to insert tables, 
pictures, clip art and links. To insert a 
table in the Insert Table drop down 
point to the number of rows and col-
umns and click.  
 
Clicking the Picture icon opens Win-
dows Explorer to select a picture to 
insert into the document. Browse to 
and select the picture and click Open. 
The picture is uploaded and inserted 
into the document.   
 
Clicking the Clip Art icon opens a 
search box. Type in a description and 
click the search symbol. Browse 
through the clip are pieces, select one 
and click the Insert button.   
 
Once a picture or clip art has been up-
loaded a Picture Tools Format tab ap-
pears when the graphic is selected. 
Tools are available to Grow or Shrink 
the picture and add a Picture Style.   
 
The Page Layout tab specifies page 
setup and paragraph indent and spac-
ing. Page Setup options include mar-
gins, page orientation and size.  
 
Save the document when it is com-
plete. Clicking Save on the File tab 
saves it on your SkyDrive. Clicking 
Save As allows you to download a 
copy and save it on your hard drive.  
 

Excel Web App 

The Home tab has font formatting and 
alignment, number formatting and 
table formatting. The Cell commands 
allow for insertion or deletion of rows, 
columns, cells and new sheets. The 



Page  8 

                       THE WYSIWYG                                                                                                  October  2013 

 
The Insert tab has a New Slide button 
to open the dialog to select a slide 
style to add to the presentation. Add-
ing pictures and clip art is same as in 
the Word Web App. Shapes and 
SmartArt are added in the Illustrations 
group. 
 
The Text group contains the Text Box 
icon. 
 
The Design tab offers the same 
themes and variations shown in creat-
ing the presentation. So if you decide 
that the selected theme isn’t working 
change it to one more suitable. Set the 
animation on the slide and timing or 
reorder the animations on the Anima-
tion tab. Slide transitions are limited 
to none, fade and push and are con-
trolled on the Transitions tab. The 
View tab has three Presentation Views 
as well as Notes and Comments. The 
Editing View is the normal view you 
would use in PowerPoint with slide 
icons for selecting or sorting and the 
active slide pane. The other options 
are Reading View and Slide Show.   

 
This article has been obtained from 

APCUG with the author’s permission 

for publication by APCUG member 

groups. 

Formulas group includes the com-
monly used functions. The Data 
group can refresh the workbook con-
nections and recalculate or search the 
workbook to Find something. 
 
Insert Functions, Tables, Charts and 
Links from the Insert tab. The num-
ber of charts available is limited but 
sufficient.   
 
The View tab has only two options. 
You can use the standard Editing 
View or choose Reading View to 
look at the data without toolbars. 
 

PowerPoint Web App  

When creating a PowerPoint presen-
tation on the web app there a very 
limited number of themes. In the first 
dialog box chose a theme. There are 
also four customize buttons that 
change the color scheme. Once the 
theme has been set and the Apply 
button clicked a new presentation 
opens.  
 
The Home tab has the Clipboard, 
Slides, Font, Paragraph and Drawings 
groups. The font and paragraph for-
matting commands are limited to the 
basic functions. The number of 
shapes is limited but you still have 
styles, fill and outline. I like the new 
Delete group as it provides one click 
option to delete a slide. 

However, it is your children that are 
priceless. If you are going to a big 
outing, perhaps an amusement park, 
or even the mall, take a picture of 
them. Don't say you did this in case 
they get lost or abducted - that would 
just create unnecessary fear. Take the 
photo as if you were just capturing the 
moment they arrived at your recrea-
tion destination. Now you have a 
photo of exactly how they look and 
what they are wearing on that day. 
Even if they should just happen to 
wander to the toy section in the store, 
you can share that photo with store 
workers or security guards to help find 
them. This tip alone will make your 
life easier and less stressful. 
 

2. Where Did These Come From? 

If you need to take something apart to 
try to repair it, use your phone camera 
to take a picture of the item BEFORE 
you get after it with a butter knife. 
Take pictures at every stage of the 
disassembly. Now you have some-
thing to guide your reassembly efforts 
and jog your memory as to where 
each part belongs. Plus, should you 
feel the desire to share your handiness 
on the Internet, you have documenta-
tion of what you did. You never 
know, you might be the first person to 
find an easy way to fix something and 
help someone else. 
 

3. Why I Was Late For Work 

Recently, where I live was hit by a 
winter storm named Nemo. Which 
was a good name for it, because after 
all the snow fell and the winds drifted 
over anything that stood still, you 
would have a hard time finding any-
thing. Our one car sat through the 
storm, dutifully waiting to be driven 
until today. When I went out to the 
car, I knew I would have to shovel 
around it and maybe put some traction 
sand down. That went all fine and 
dandy, but backing out over the rest of 
the driveway proved difficult. The car 
slid on the ice and ended up in a bit of 
a snow bank. So, I took pictures. Yes, 
that's my car in the picture. I got to 
work on time, but had someone ques-
tioned me, I could show them what I 
was up against. 

Facebook, Pinterest, Tumblr, wher-
ever. 
 

1. Take a Picture of Your Kids 

Yes, those of us blessed with the fun-
sized versions of ourselves take pic-
tures of our kids constantly. We do 
this so we can see them grow, and re-
member those moments that we seem 
to only cherish after the fact. Those 
pictures are almost priceless.  
 
 

"Does your phone have a camera on 
it?" said no one since 2005.  
 

N 
obody even asks how many 
megapixels your phone's cam-
era has anymore. With the 

ubiquity of smartphones today and the 
resolution of the cameras they have in 
them, why does anyone even sell a 
point-and-shoot digital camera any-
more? All you need is a decent smart-
phone to take your vacation pictures 
and click a button to upload them to 

� � � � � 

Ten Ways Your Smartphone Camera Can Make Ten Ways Your Smartphone Camera Can Make Ten Ways Your Smartphone Camera Can Make Ten Ways Your Smartphone Camera Can Make 

Life EasierLife EasierLife EasierLife Easier    
by Guy McDowell, Writer, MakeUseOf.Com 

http://goo.gl/LB6u1 
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 If your e-mail or mail address 

changes, please e-mail:  

secretary@SterlingHeights Com-

puterClub.org 

4. Can You Tell Me What Your 

Computer is Doing? 

Many of us are familiar with the Print 
Screen button and using screen cap-
ture software, and may have even 
used them to document a computer 
issue. Those tools are fine for systems 
that are functioning properly. Then 
there are those systems that just won't 
let you do anything. Take a picture of 
the screen and e-mail it from your 
smartphone to whomever is trying to 
help you with your computer. In-
stantly, they will see what you  
see. (Yes, that's my computer screen.) 
With that information, the rate at 
which they can fix the problem has 
just increased rapidly. This tip applies 
to just about any malfunctioning de-
vice really. 
 

5. Nice Layout. Too Bad About the 

Lighting. 

If you’re a budding photographer, use 
your phone to take pictures of poten-
tial subjects at different times during 
the day, or even the year. Take pic-
tures of your subject from different 
angles and different distances or view-
points. This will help you to under-
stand how the natural lighting and en-
vironment affects your subject. 
 

6. But Mark and Spencer Has This 

Item for 5p Less! 

People are finally getting a little 
smarter about their shopping habits 
and not willing to just pay whatever 
the store wants. Your smartphone 
camera can go a long way in helping 
you to negotiate a lesser price. Of 
course, there are the fancy apps that 
allow you to use the camera to scan 
barcodes or QR codes and compare 
prices at different retailers. Unfortu-
nately, those only work on items with 
codes that actually have information 
in the application's database. But if 
you can take a picture of the item 
showing its price, you now have proof 
you can use with that store's competi-
tor to get the price that you want.  
 

7. What Was The Phone Number 

For That Car For Sale? 

Most people buy used cars, and many 
buy them from someone who just 

wants to sell their car. So when you're 
out and about looking at cars, take 
pictures of it with the cellphone. Take 
pictures of the 'for sale' sign so you 
have the name and number to call and 
any other information written on it. 
Take pictures of as much of the car as 
you can including dents and dings. 
That will help you in negotiations. 
You might come to a tentative deal on 
the phone, then show up later and the 
car has a new ding. Now you can 
prove that it does and push lower. 
 

8. It Wasn't Like That When I Sent 

It 

Recently we shipped a friend's car out 
west. The shippers broke the spoiler 
on the car. Had we thought to take a 
picture of the car before they loaded 
it, we could have made our friend's 
life easier. They could have easily 
shown that the car was fine before it 
went on the truck. This little trick can 
apply to ANYTHING that you ship. 
As another example, some manufac-
turers now take pictures of each ship-
ment before it goes out the door. You 
can see the waybill, bill of goods and 
the items in the shipment. This pro-
tects them, and you, from things going 
missing. 
 

9. Ibid 

Are you a college or university stu-
dent? Are you doing lots of research 
in the reserved or special collections? 
Whip out the cell phone, take pictures 
of the relevant pages as well as the 
ISBN, Cover and the Library of Con-
gress Cataloging-in-Publication page. 
Now you can use that information to 
properly annotate and document your 
research, at your leisure. The book 
called, "Wireless Networking in the 
Developing World" is a  
good read, look it up. Man, I wish I 
had that when I was in school. Back 
then photocopies were sometimes as 
much as 50 cents a piece and you can't 
photocopy a lot of the ancient texts 
that I used. 
 

10. How Did That Get In There? 

Kids put weird things in weird places. 
Two of those places are the nose and 
ears. With the cellphone's flash on, 

you can use the camera function al-
most like a scope to see what they've 
done now. Of course this works for 
adults too, if there's maybe an ear in-
fection or an abscessed tooth. It's your 
camera. Where you put it is up to you! 
 

But wait, there's more... 

We could go on all day about different 
ways to use your smartphone camera 
to make your life easier or simpler. 

 

• Don't have a mirror handy while 

trying on fab hats? Take a pic-
ture! 
 

• See something you'd like to get 

your spouse, but you're not sure if 
they'd like it? Take a picture! 

 

• See someone driving a car and 

reading a book at the same time? 
Take a picture! 
 

• Trying to lose weight and need to 

keep a food log? What do you 
think you should do? Yes, take a 
picture! 

 

This article has been obtained from 

APCUG with the author’s permission 

for publication by APCUG member 

groups. 

� � � � � 

PPPPIG SIGIG SIGIG SIGIG SIG    
 

J 
oin fellow club members for a 
light supper and casual conver-
sation before the next club 

meeting at Travan’s Restaurant, on 
Hayes, across from our meeting loca-
tion. It starts at 6:00, and ends in time 
to get to the meeting. This great eating 
and fellowship meeting is referred to 
as “The PIG SIG.”  
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WWWWorld Wide Web    orld Wide Web    orld Wide Web    orld Wide Web    

Column on the Club Column on the Club Column on the Club Column on the Club 

Web SiteWeb SiteWeb SiteWeb Site    
 

Check out the WebPageReviews sec-
tion on the club’s web site. You can 
see past web sites reviewed in the col-
umn on our club web page. They are 
arranged into various topics to help 
locate a specific site. 

� � � � � 

 WYSIWYG WEB WATCH (wwwWYSIWYG WEB WATCH (wwwWYSIWYG WEB WATCH (wwwWYSIWYG WEB WATCH (www) 
by Paul Baecker    webwatch@sterlingheightscomputerclub.org 

This column attempts to locate sites 
containing valuable, amusing and free 

content, with no 
o v e r b e a r i n g 
pressure to pur-
chase anything.  
Send your fa-
vorite entertain-
ing, helpful or 
just plain use-
less sites (a de-

scription is optional) to the e-address 
noted above, for inclusion in a future 
WYSIWYG issue.   

Organize a local group or find one of 
the thousands already meeting up 
face-to-face with interests and hobbies 
like yours. 
http://www.meetup.com 
 
Places that have passed into obscurity, 
lesser known subjects of historical 
interest, and the more shadowy cor-
ners of the world.  Over 400 pictorial 
collections of abandoned vessels, ve-
hicles, aircraft, places, more. 
http://www.urbanghostsmedia.com 
 
Hilarious bunny suicides comic col-
lection. 
h t t p : / / b l o g . j i m m y r . c o m /
Hilarious_Bunny_Suicides_Comic_ 
14_2008.php 
 
Rare classic cars from the 30s as well 
as classic American cars, all with lots 
of chrome.  Also, rare autos at various 
international car shows – Talbot, Alfa, 
Delage, Ferrari, more. 
http://www.cromoclassico.com 
 
Go back to personal finance school 
with courses that will have you build-
ing your portfolio in no time.  No 
need to register to read the valuable 
contents.  Stocks, funds, bonds, and 
portfolio categories, with many short 
courses in each. 
h t t p : / / n e ws . m o r n i n g s t a r . c o m /
classroom2/home.asp?colId=397&CN 
=COM 

Fee & free woodworking plans, free 
tutorials, how-to's, project ideas, & 
shop tips. 
http://www.binkyswoodworking.com 
 
Two galleries of Fillmore Theatre mu-
sic concert posters from the late 60s. 
http://www.thescreamonline.com/art/
art3-2/fillmore/ 
 
Got an hour to kill?  Watch (nearly) 
every version of Windows being in-
stalled (MS-DOS through Windows 
8). 
http://betanews.com/2013/06/04/got-
an-hour-to-kill-watch-nearly-every-
version-of-windows-being-installed/ 
 
Move the mouse for an unending ka-
leidoscope. 
http://darkpsychedelic.ru/FV_17.html 
 
ANTS - Nature's Secret Power: spe-
cial macro film technology displays 
the mysterious world of these social 
insects. One-hour video. 
http://www.youtube.com/watch?v=Z-
gIx7LXcQM 
 
Pick the numbers from 1 to 100 in a 
timed challenge. 
ht tp : / /www.sporc le .com/games/
RobPro/1-100-click-me 
 
Variety of images from scanning and 
transmission electron microscopes. 
http://www.dartmouth.edu/~emlab/
gallery/ 
 
Simple, step-by-step pictorial instruc-
tions on how to do over 300 practical 
(and not-so-practical) activities. 
http://www.showmenow.com 
 
Military aviation history and heritage 
of the Michigan Air National Guard at 
Selfridge ANG Base. 
h t t p : / / ww w. 1 2 7 wg . a n g . a f . mi l /
resources/history&heritage.asp 
 
The Library of Congress displays 
19600 historical photos. 

h t tp : / / www. f l i c k r . co m/ p ho to s /
library_of_congress/ 
 
Cartoons from the deranged folks who 
bring you Shoebox greeting cards.  
Search by category or author. 
http://www.shoeboxblog.com 
 
An illustrated travel guide to Great 
Britain based on personal experience 
of the locations, with pictures of land-
scapes, historical buildings, moor-
lands, villages, more. 
http://www.beenthere-donethat.org.uk 
 
Collection of challenging logic puz-
zles and word games for enthusiasts of 
all ages. 
http://www.puzzlersparadise.com 
 
The short-course on-line library of 
digital photography – tips and advice 
for buying and using digital cameras. 
http://www.shortcourses.com 
 
Takes the mystery out of all things 
mechanical, so that women can fix, 
renew and restore their own stuff.  
Ask questions, read articles, watch 
videos. 
http://seejanedrill.com 
 
Play the piano on your keyboard with 
this opensource MIDI keyboard appli-
cation. 
http://freepiano.tiwb.com 


